
Assembly Tutorial

 

This tutorial is designed to step you through creating an assembly. As you go through this tutorial, later 
procedures will assume that you understand all earlier procedures. Because of this, it is very important 
that you carefully step through this guide, understanding everything along the way and following all 
steps in order. 

We would like to cover a few key items before starting the step-by-step instructions of the tutorial. It is 
very important you completely understand these items: 

ITEM 1) PickPoints 

PICKPOINTS ARE USED FOR EVERYTHING. The assembly part of the software is largely run in 
full 3D. Because a computer screen is only 2D, there is an unlimited amount of depth behind and in 
front of the cursor. A PickPoint is a point in 3D space that can be used for creating, editing, and placing 
parts in assembly. PickPoints can be placed in a 2D environment by having their depth manually 
entered. 

There are 2 types of PickPoints; Automatically created by the part (various colors) & User defined 
points (green). In addition our 0,0,0 point is an automatic point that resides at the center of the Tri-Star. 
The Tri-Star is our directional definition locator. 

ITEM 2) Center Line & Apex 
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Center Line: In the assembly environment we are working exclusively with the center line of a part, as 
compared to the inside or outside. 

Apex: The bend locations are created in assembly exclusively with the apex. Our definition of apex is 
the intersection of the straight tubes as if there wasn’t a radius. This is demonstrated in the picture 
below. 

 

ITEM 3) Define the parts in the assembly interface 

It is possible to create parts in the template and custom part interfaces, however, starting out this way 
tends to get confusing for new users of the software. It appears that there is a higher level of success 
with customers who start out designing parts in the assembly interface. 

ITEM 4) Sense of Direction 

It seams to work the best if users think as if they are standing behind the vehicle. This way left is left 
and right is right. Take a minute and examine the tri-star to get your orientation. 

Notice how the truck in the picture is setup with the same orientation. 

 

Start out by selecting the New Assembly item from the File pull down menu. Alternatively, you may 
also click the New Assembly icon in the main toolbar. 

The Assembly window is broke down into 2 main areas. On the left is the tab area where we make our 
feature selections and value inputs. On the right is the graphical area where we make our screen 
selections and can visually see our assembly. 
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Creating the 1st Part: 
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Notice we have highlighted the part we are going to work on. The dimensions for this part are 
displayed in the picture below. 

 

We are going to create the 4 PickPoints representing this part. 

Select the “PickPoints” Tab. 

 

Click the “Set Reference” button and Pick the center of the “Tri-Star”. It maybe hard to see, however, 
there is a green pickpoint at the center. When the pickpoint is selected it will turn RED. 
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Enter a value of 36 into the Ceiling field. 

 

You will notice a purple pickpoint located straight up from our Tri-Star. This is 36 to Ceiling from our 
selected reference point which in this case is our Tri-Star location. 
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If we take a careful look at our part design, you will notice the bend locations are not straight up but are 
placed 6 inches in. 
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Enter 6 into the Left field. 

 

Press the Apply button. This will turn the new pickpoint from a purple circle to a solid green dot. Click 
the Clear Values button now to clear the fields. Your display window should look similar to the picture 
at the right. 

Select your new PickPoint so that it becomes our “Reference Point”. Now this point should turn red. 
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Enter 36 in the Left field. Notice the hollow pickpoint up and to the left from your reference point. This 
is shown in the picture below. WARNING: Make sure the other 5 fields have only zero. 

Select the Apply button. 
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Select the pickpoint at the center of the Tri-Star as your reference point. 
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Enter 48 into the Left field. Again make sure the other 5 fields have only 0. Notice the hollow pickpoint 
displayed as shown in the picture below. 
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Go to the Tools menu on the main menu bar and select Die Library. 

 

Click the Add New button. Type 2.0 in the Die Name field, 270 in the Die Angle field, 2 in the Die Size 
CLR field, 2 in the Achieved CLR field, 2 in the Calibrated CLR field, and 0 in the Bend Location 
Offset field. 
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Go to the Tools tab on the main menu bar again and select Tube / Pipe Library. Click the Add New 
button. Enter 1 in the Material Name field. Enter 1 in the diameter field and 0.1 in the wall thickness 
field. Click the Apply button. Click the Close button. 

 

In the Main tab, select 2.0 in the Die for new Parts drop down menu and 1 in the Material for new Parts 
drop down menu. 
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Select the “Main” tab. 

On the Main tab we do our part creation and manipulation. Select the “Bent Part” button. 

Now we are asked for the Number of Bends. As you can see from our diagram on the right the part 
consists of 2 bends. Replace the default of 1 with a 2. 

Click the OK button to close the Number of Bends window. 

Now we are going to use the cursor to select the pickpoints for the part. When you are selecting the 
pickpoints for a bent part, select the first end of the part, the apex of each bend in order, and the other 
end of the part. To start this part, click the point at the center of the Tri-Star. 

The pickpoint that you select will turn red and a line will be drawn between it and your cursor. Both of 
these things are indications that you have successfully selected the pickpoint. 
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Click the top right point, followed by the top left point, followed by the bottom left point. 

 

After the last selection the Part Name box will appear. The first part that is created has a default name 
of “Part 0”. You can change the part name if you desire, however, we will be referring to this part a s 
“Part 0” through out the rest of this guide. 

 

Select the “OK” button to continue. 

Note how the part changes. First the apex points we used are now changed to arcs. Second there are 
several new pickpoints on the part. These “part” pickpoints are located at the start, end, center, and 
midpoint of the arc and at the apex of the bend. 
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You will now find our new part as a item in our Master Part List. The Master Part List is where the 
parts we have used or ones we want to use are stored. This is NOT a list of the parts in our assembly, it 
is simply a list of parts that are available to be used in the current assembly project. This list can be 
found under the Main Tab. 

 

Time to create our 2nd part. This part is exactly the same as the first part. We are going to create one 
more pickpoint and then “paste” the part at that location. 

The distance from our 1st part to our 2nd part is 72 inches (shown below). 

 

We will first create the new pickpoint 72 inches towards the front. 

Select the PickPoints tab. 

Select the Set Reference button. 

Select the Tri-Star point. 

http://www.bend-tech.com/wiki/index.php?title=File:W34.PNG
http://www.bend-tech.com/wiki/index.php?title=File:W35.PNG
http://www.bend-tech.com/wiki/index.php?title=File:W36.PNG
http://www.bend-tech.com/wiki/index.php?title=File:W37.PNG


 

Enter 72 into the Front field. You will find a new hollow pickpoint in your assembly as seen in the 
picture below. 

Select the Apply command button. 

  

Now we are going to “Paste” the part. Select “Part 0” from the Master Part List. 

 

Now select the Paste Part command button. 

As you move the cursor over your assembly you will find a copy of “Part 0” attached to your cursor. 
Help text will also be displayed, prompting you to “Select a PickPoint to locate this part” (shown 
below). Select our newest pickpoint. 
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Our 3rd part is like our first two parts except it has shorter legs. We will first paste the same part again, 
then we can shorten the legs. 

As shown, the part is 36 inches to the front of our 1st part. 

 

As shown below, this part will have its legs shortened. 

 

Select the PickPoints tab. Select the Set Reference button. Select the tri-star point. Enter 36 into the 
Front field. Select the Apply button. 
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Now we are going to “Paste” the part. Select “Part 0” from the Master Parts List. 

Now select the Paste Part command button. 

The assembly project should look like the picture below. 

 

Now we need to adjust our center part. As you can see we know the straight sections of the part need to 
be 7 inches. The process we will use will be to place 2 additional PickPoints and then move each end of 
the part to the new location. 

 

We are going to learn about a new technique, 2 Points, to place a PickPoint. Select the PickPoints Tab. 
Now select the Set Line button that is within the PickPoint Tab. The Two Points function allows you to 
place a line and then place a pickpoint on that line by entering the distance from the first end of the line 
that the new point should be. 

Click on the start point of the arc of the first bend on the third part. This point will be purple. Look at 
the picture below to see which point you should click. 
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Now click on the point that you used to place the third part. See the picture below to make sure you are 
selecting the correct point. 

 

Enter 7 in the Move Amount field. If your assembly project looks like the picture below, click the 
Apply button. 

 

Now we need to do the same thing to the other side of the same part. Start by clicking the Set Line 
button. Click the end point of the arc of the last bend of the part (tangent of the last straight section), 
followed by the end point of the part. These are the same points you chose before but on the mirror 
opposite side of the part. 7 should still be entered in the Move Amount field, but if it is not, enter it. 
Click the Apply button. Your display window should look like the picture below. 
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Now we will shorten the legs of the third part. Go to the Edit tab and click on the Move Feature button. 
Move Feature allows you to move a single pickpoint of a part without moving the rest of the part. Click 
the point that is indicated in the picture below. 

http://www.bend-tech.com/wiki/index.php?title=File:W52.PNG


 

Click the bottom right point. 

 

You should see two green points in the display window. Both of them are points that you created a few 
steps ago using the Two Points feature. Click the right point. This will move the start point of the part 
from its original location to the location of the pickpoint. 
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You must now shorten the other leg. Click the Move Feature button and click on either one of the two 
blue points that appears on the middle part. Clicking either point will select that part. Now the part will 
have two additional blue points, one at the start and one at the end of the part. Click the one at the end 
of the part, as indicated in the picture below. 

 

You will see two green points in the display window. Click the left one to shorten the left leg of the 
part, as shown in the picture below. 
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Its time to add our 2 horizontal rungs to our assembly. 

As seen in the picture below, the rungs are up 4 inches from the bottom of the assembly. 

 

Because the 1st and 2nd parts’ legs are not straight up (slanted in) the “2 point” function will not work. 
Remember the “2 point” function is a distance down a line. In this case we want to go straight up 4 
inches and don’t know how far down the leg that will be. Lets get started. Go to the PickPoints Tab. 

Select the Plane / Arc Tab that is within the PickPoints Tab. 

Your screen should look like the picture below. 

When using the Plane option we are going to be making 3 PickPoint selections. The first one is for the 
plane reference and the 2nd two pickpoint selections are defining a line. We are looking for a plane to 
intersect a line. 

Click the Set Reference button. 
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Select the PickPoint on the right leg of the first part as shown in the diagram below. This point will be 
the base point of the plane. 

 

You will see a circular pattern appear around the pickpoint. 

The direction of the plane is determined by the Plane options under the tab. In our case the default “Z 
Plane” is the correct plane. 

The next 2 PickPoints define the line which will intersect the plane. 

Select the pickpoint at the start of the leg (this is the same point you picked for the plane and is also the 
tri-star point). 
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Select the point at the beginning of the first bend. 

 

Your screen should look like the picture below. Click the Apply button. The point at the center of the 
plane will turn green. You must now repeat this process on the other three legs. Just click the Set 
Reference button, click the bottom of a leg, click the same point again and click the point at the 
beginning of the bend on that leg. Click the Apply button to place the point each time. 
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After all four points have been placed, your screen should look exactly like the picture below. 

 

Now that we have our PickPoints defined it is time to make our rungs. 

Select the Main Tab. 

If you have more than two parts in your Master Part List, click the Flush button. Flush will remove any 
unused parts from the Master Part List. 

Select the Straight Part command button. 
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Select the 1st new PickPoint as shown in the picture below. 

 

Click on the pickpoint that will be the opposite end of the first rung. Your screen should look like the 
picture below. 
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You have two pickpoints left and one rung to make. It doesn’t matter what order you select them, just 
select both of the two remaining pickpoints that we created with the Plane feature. Your Screen should 
look like the picture below. 

 

The final four parts are also straight parts. 

As before we know the locations based upon from the floor to the ceiling. 

The picture below shows us enough dimensions to finish. 
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Select the PickPoints Tab. 

Select the Plane Tab that is within the PickPoint Tab. 

 

You will now need to repeat the exact same process that you used to place the last four pickpoints. The 
only difference is that now you will need to have 12 in the Move Amount field instead of 4. When you 
are finished your screen should look like the picture below. 

 

You now need to go to the Main tab and click on the Straight Part button. There are four parts left to be 
created. Each part is a line between one of the pickpoints you just made and one of the legs of the 
middle part. Look at the picture below to see what two pickpoints you should select first. 
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Your screen should look like the picture below. 
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The picture above shows the next two points you should select. The picture below shows what your 
screen will look like after you select the points. 
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You have two parts left to place. The picture below shows the placement of the first one. The final part 
of the assembly project is just like the one you just made, except on the other side of the assembly. Use 
the picture at the end of this tutorial if you are having trouble figuring out where to place the part. 
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Here is our finished project. To see your project fully shaded like the picture below, click the Display 
Mode button on the tool bar and click on Shaded. 
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Go to the File menu on the main menu bar. Click the Save As button. Name the project whatever you 
want and click the save button. You are now finished with the assembly tutorial. 
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